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Chapter 1: About MDCStore Data Manager
Database Schema Installation

This guide explains how to install the MDCStore™ High Content Data Management Solution
version 2.3 database schema for use with Microsoft SQL Server and Oracle databases for
64-bit systems only. For 32-bit systems, see the MDCStore High Content Data Management
Solution Database Schema Installation Guide, Revision J for software version 2.3 of this guide.
Updating an existing MDCStore Data Manager database schema from version 2.0, 2.1, or 2.2
to version 2.3 is also explained.

CAUTION! The database-related information in this document is provided for
guidance only. Molecular Devices is not responsible for damage to existing user data
due to network problems, power failure, or unexpected termination of the database.
Molecular Devices is not responsible for poor database performance due to an
unoptimized database environment. Molecular Devices strongly recommends that
you hire a database administrator (DBA) to set up, maintain, and optimize the
database for your installation. A DBA will monitor the usage of your database
configuration and can optimize the database for best performance. For more
information about database installation, security, operation, and optimization, contact
the appropriate software vendor.

Product Compatibility
The MDCStore Data Manager version 2.3 database schema is compatible with:

Versions 2.0 or later of the MetaXpress® High-Content Image Acquisition and Analysis
Software
Version 1.0 or later of the MetaXpress® PowerCore™ High-Content Distributed Image
Analysis Software
Version 2.0 or later of the AcuityXpress™ High-Content Informatics Software
Version 5.1 and newer of the MetaXpress Software requires version 2.3 of the
MDCStore Data Manager database schema.

Version 2.3 of the MDCStore Data Manager database schema is not compatible with versions
1.6 and 1.7 of the MetaXpress Software or version 1.0 of the AcuityXpress Software.

Additional information is available on the Web:

For general information, go to www.moleculardevices.com.
To search the knowledge base, go to www.moleculardevices.com/support.

1
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Required Documents
Before you install the MDCStore Data Manager database schema, you should review the
information in the following documents:

Molecular Devices High Content Screening Computer Specifications
Molecular Devices Complete Solution HCS IT Requirements

These documents are available in the knowledge base on the Molecular Devices support site:
www.moleculardevices.com/support.

Obtaining Support
Molecular Devices is a leading worldwide manufacturer and distributor of analytical
instrumentation, software and reagents. We are committed to the quality of our products
and to fully supporting our customers with the highest possible level of technical service.

Our support web site, www.moleculardevices.com/support , has a link to the Knowledge
Base with technical notes, software upgrades, safety data sheets, and other resources. If you
do not find the answers you are seeking, follow the links to the Technical Support Service
Request Form to send an email message to a pool of technical support representatives.

You can contact your local representative or contact Molecular Devices Technical Support by
telephone at 800-635-5577 (U.S. only) or +1 408-747-1700. In Europe call +44 (0) 118 944
8000.

Please have your instrument serial number or Work Order number, and your software
version number available when you call.

http://www.moleculardevices.com/support.html
http://www.moleculardevices.com/support.html
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Chapter 2: Installing the MDCStore Data Manager
Database Schema for SQL Server

This chapter explains how to install the MDCStore™ High Content Data Management Solution
version 2.3 database schema for Microsoft SQL Server 2005, Microsoft SQL Server 2012, or
Microsoft SQL Server 2014 databases. Throughout this section, the Microsoft SQL Server
database software is referred to as SQL Server.

These instructions are for a new installation of the MDCStore Data Manager database schema
only. To update an existing installation of the MDCStore Data Manager database schema, see
Updating an Existing MDCStore Data Manager Database Schema on page 49.

Note: If you have an Oracle database, do not use these instructions. See Installing the
MDCStore Data Manager Database Schema for Oracle on page 15. To install Microsoft
SQL Server 2014 Express, see Installing SQL Server 2014 Express on page 57.

Topics in this section:

Prerequisites on page 7
Choosing the Appropriate Installer on page 8
Creating User Accounts for the MDCStore Database on page 13

Prerequisites
Before you install the MDCStore Data Manager database schema, you must set up aWindows
server and install the SQL Server database software. Both the computer operating system
and the database software must be installed with U.S. English as the language setting. For
instructions, see the documentation from Microsoft.

Molecular Devices recommends that you use a dedicated server for the MDCStore Data
Manager database. Using a server that hosts other databases or applications can decrease
performance.

Note: When installing and setting up a database on Windows 7, make sure that you
have logged into Windows 7 with full administrator rights, and that you have full
access to the folder where the database is to be installed. Molecular Devices
recommends that you set the User Access Control (UAC) on the computer to the
lowest security setting.

2
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Required Documents
Before you install the MDCStore Data Manager database schema, you should review the
information in the following documents:

Molecular Devices High Content Screening Computer Specifications
Molecular Devices Complete Solution HCS IT Requirements

These documents are available in the knowledge base on the Molecular Devices support site:
www.moleculardevices.com/support.

Choosing the Appropriate Installer
The MDCStore Data Manager database schema installer is available on the MetaXpress® High-
Content Image Acquisition and Analysis Software Installation flash drive and also as a
standalone installer. The software must be installed on a 64-bit operating system.

If you are installing from the MetaXpress Software Installation flash drive, install the
provided 64-bit version. For complete instructions, see the MetaXpress High-Content
Image Acquisition and Analysis Software Suite Installation and Update Guide.
If you are installing from a standalone installer, make sure that you download the
appropriate version. Instructions for using the standalone installer are included in this
chapter. See Using the Standalone Installer on page 8.

Using the Standalone Installer
To install the MDCStore Data Manager database schema from the standalone installer:

1. Log in to the computer where you want to install the MDCStore Data Manager database
schema.
If you are installing from the MetaXpress Software Installation flash drive, see the
MetaXpress High-Content Image Acquisition and Analysis Software Suite Installation and
Update Guide.

2. Right-click the downloaded MDCStore Data Manager archive file and select Run as
Administrator.

3. In the WinZip Self Extractor dialog, click Setup.
The system checks for prerequisites.

http://www.moleculardevices.com/support.html
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4. If required components are missing, a warning is displayed, and you must click Install to
install the components and continue. Follow the installation instructions for any required
components.
When the prerequisite check is complete and all required components are installed, the
MDCStore Database Installer Setup Wizard dialog is displayed.

5. Click Next and follow the on-screen instructions to set up the MDCStore Data Manager
database schema installer.
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6. In the Confirm Installation dialog, click Next to start the database installation.
During the installation, the Setup MDCSTORE dialog is displayed.
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7. Click Install\Upgrade MDCStore.
The Setup MDCSTORE message is displayed.
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8. Click Yes.
The Database Installation and Update dialog is displayed.

9. Select Create a new database on this computer, and then provide the information
required to create the database:

In the Computer\SQL Instance field, select the appropriate instance, such as
COMPUTERNAME\SQLSERVER.
In the New database name field, type a name for the new database.
Click Create, and then specify a directory in which to install the database.
Click Browse to select the directory.
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Note: Molecular Devices recommends installing the database on a computer
with at least two separate partitions, storing the database on the second
partition (usually a separate hard drive labeled as “D:”) rather than the main
partition with the operating system and software.
Storing the data on the hard drive that does not have the operating system
and main applications running increases performance and ensures that your
data is accessible even if the operating system located on the "C:" drive is
damaged or needs to be reinstalled.

Do not install on an external hard drive because it can be turned off and
disconnect access to your data.
Do not install on a mapped or network drive for the same reason.

10. Click OK to continue.
When the installation is successful, the following message is displayed: The database
has been installed successfully.

11. In the Installation Complete dialog, click Close, and then click OK in the dialog that
confirms the creation of the data source.
The MDCStore Data Manager database schema is installed. To set up user accounts for
the MDCStore Data Manager database, see Creating User Accounts for the MDCStore
Database on page 13.

Creating User Accounts for the MDCStore Database
By default, there is a single user account for the SQL Server MDCStore Data Manager
database: the sa (system administrator) account. If multiple users need to access the
database, log in using the sa account to create and configure separate accounts for each user
so that they do not need to use the sa login.

To create user accounts for the MDCStore Data Manager database, use the MDCStoreTools
Utility. See the MDCStoreTools Data Management Utility User Guide included on the
MetaXpress Software Installation flash drive.
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Note: The MDCStore Data Manager schema comes pre-installed on the instrument
workstation. For the MetaXpress Software version 4.0 and above, the default User
Login Name isMolDev, the default System Administrator Login Name is sa, and the
default password for both is moldev.

For versions of the software earlier than 4.0, the default User Login Name and
password wasmdc. You might need to log in usingmdc if you had an earlier version
of the software on your instrument workstation. For increased security, you can
change the password for the system administrator to something other than the
default password shipped with the system.
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Chapter 3: Installing the MDCStore Data Manager
Database Schema for Oracle

This chapter explains how to install the MDCStore™High Content Data Management Solution
version 2.3 database schema for Oracle databases. These instructions are for a new
installation of the MDCStore Data Manager database schema only. To update an existing
installation of the MDCStore Data Manager database schema, see Updating an Existing
MDCStore Data Manager Database Schema on page 49.

Note: If you are using SQL Server do not use these instructions. See Installing the
MDCStore Data Manager Database Schema for SQL Server on page 7. To use SQL
Server Express, see Installing SQL Server 2014 Express on page 57.

Topics in this section:

Prerequisites on page 15
About Installing the MDCStore Data Manager Database Schema Database Schema on
Oracle on page 16
Choosing the Appropriate Installer on page 16
Using the Standalone Installer on page 17
Creating Tablespaces and Configuring Users on page 19
Creating User Accounts for the MDCStore Database on page 22

Prerequisites
Before you install the MDCStore Data Manager database schema, you must set up a server
and install the Oracle database software. Both the computer operating system and the
database software must be installed with U.S. English as the language setting. For instructions,
see the vendor’s documentation.

Note: Oracle database names cannot contain spaces or special characters, nor can
the name be longer than 23 characters. The names screening 1 and screening#2 are
not valid database names. The names screening_1 and screening_2 are valid database
names. Limit the characters used for the database names to alphanumeric (0–9, a–z)
and underscores (_).

3
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Molecular Devices recommends that you use a dedicated server for the MDCStore Data
Manager database. Using a server that hosts other databases or applications might decrease
performance.

Required Documents
Before you install the MDCStore Data Manager database schema, you should review the
information in the following documents:

Molecular Devices High Content Screening Computer Specifications
Molecular Devices Complete Solution HCS IT Requirements

These documents are available in the knowledge base on the Molecular Devices support site:
www.moleculardevices.com/support.

About Installing the MDCStore Data Manager
Database Schema Database Schema on Oracle

There can be significant differences from one version of Oracle to another, and these can
affect the way the MDCStore Data Manager database schema is installed and used. For
example, Oracle 10g introduced big tablespaces. These have not been tested and they are
not described in this document.

Keep these points in mind when installing the schema on Oracle:

The MDCStore Data Manager database schema can be installed on different partitions.
There are no restrictions on creating global users in Oracle through the MDCStore Data
Manager version 2.3. Administrators must choose a user creation policy that meets their
requirements.

Consult a database administrator for more information.

Choosing the Appropriate Installer
The MDCStore Data Manager database schema installer is available on the MetaXpress®High-
Content Image Acquisition and Analysis Software Installation flash drive and also as a
standalone installer. The software must be installed on a 64-bit operating system.

If you are installing from the MetaXpress Software Installation flash drive, install the
provided 64-bit version. For complete instructions, see the MetaXpress High-Content
Image Acquisition and Analysis Software Suite Installation and Update Guide.
If you are installing from a standalone installer, make sure that you download the
appropriate version. Instructions for using the standalone installer are included in this
chapter. See Using the Standalone Installer on page 17.

http://www.moleculardevices.com/support.html
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Using the Standalone Installer
To install the MDCStore Data Manager database schema from the standalone installer:

1. Log in to the computer where you want to install the MDCStore Data Manager database
schema.
If you are installing from the MetaXpress Software Installation flash drive, see the
MetaXpress High Content Image Acquisition and Analysis Software Suite Installation and
Update Guide.

2. Right-click the downloaded MDCStore Data Manager archive file and select Run as
Administrator.

3. In the WinZip Self Extractor dialog, click Setup.
The system checks for prerequisites.
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4. If required components are missing, a warning is displayed, and you must click Install to
install the components and continue. Follow the installation instructions for any required
components.
When the prerequisite check is complete and all required components are installed, the
MDCStore Database Installer Setup Wizard dialog is displayed.

5. Click Next and follow the on-screen instructions to set up the MDCStore Data Manager
database schema installer.

6. In the Confirm Installation dialog, click Next to start the database installation.
During the installation, the Setup MDCSTORE dialog is displayed.

7. Click Database Scripts to find the location of the installation scripts, and confirm that the
scripts are present.
You must run the installer to this point to access the Oracle installation scripts. However,
do not continue using the installer to complete the installation.

8. In the Setup MDCStore screen, click Exit.
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9. Click Close.
To complete the installation, follow the instructions in Creating Tablespaces and
Configuring Users on page 19.

Creating Tablespaces and Configuring Users

CAUTION! Read the whole procedure before starting to setup an MDCStore schema
on Oracle.
If the schema contains data DO NOT run the script, because it overwrites the data
without warning and corrupts the resulting database.
To preserve existing data, use a new tablespace and schema name when installing
MDCStore Data Manager on Oracle.

When setting up a new schema, use a new schema name.

To perform these tasks, you must connect to the Oracle server as user SYS, connected as
SYSDBA. This ensures that you can:

Create tablespaces
Create users
Create groups
Grant permissions on database objects
Create and drop in database objects

Molecular Devices recommends that you have the MDCStore Data Manager schema created
by a database administrator knowledgeable in Oracle.

CAUTION! The tablespace of the MDCStore Data Manager database must be allowed
to expand past its initial size, since the database might grow significantly. Molecular
Devicesrecommends starting with 32 GB of space and installing the database on a
dedicated data partition, not on the primary drive. Using external hard drives is not
recommended since they can be easily turned off, which prevents access to the data.

To create tablespaces and configure users:

1. Open the SQL*Plus Worksheet, which is installed as part of the Oracle client program.
2. Connect to the Oracle server as user SYS, connected as SYSDBA. This requires that you

change from the default or Normal connection.
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3. In the SQL*Plus Worksheet, run the following command to create a tablespace for the
MDCStore Data Manager database schema:

Note: In the command, brackets (<>) indicate variables. You must replace this
text and the brackets with the appropriate values.
Do not type the brackets themselves. Quotation marks that appear around text,
however, are part of the command.

CREATE TABLESPACE "<your table space name>"

NOLOGGING

DATAFILE '<table space location>' SIZE <initial size of the
database (for example, 32000M)>

EXTENT MANAGEMENT LOCAL

SEGMENT SPACE MANAGEMENT AUTO;

COMMIT;

Note: Using AutoExtend is not recommended. Calculate the space requirements
of the database based on the size of experiments you plan to run, and then
create additional data files to allow the database to grow. You can approximate
the data storage space to be twice the amount of storage required for images.

For the DATAFILE '<table space location>', use these formats:
Windows: C:\ORACLE\ORADATA\MDCStore1\MDCStore.ora
Linux/UNIX: C/opt/oracle/oradata/ora1/MDCStore.dbf

CAUTION! The recommendations in this guide are for MDCStore Data
Manager database schema installation only. They are not intended to provide
guidelines for managing corporate databases. Some options might not be
appropriate for certain environments, and your database administrator must
determine whether 32 GB is a sufficient starting point. Eventually, the
tablespace requirements of the database might increase.
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4. To create a global user to be used as the schema provider, run this command:
CREATE USER <global user name> PROFILE "DEFAULT"

IDENTIFIED GLOBALLY AS "

DEFAULT TABLESPACE "<your table space name>"

TEMPORARY TABLESPACE "<your temporary table space name>"

QUOTA UNLIMITED

ON "<your table space name here>"

ACCOUNT UNLOCK;

COMMIT;

GRANT "CONNECT" TO "<global user name>";

COMMIT;

5. To change your current connection to the schema where you want to install the
MDCStore Data Manager database schema, run this command:

ALTER SESSION SET CURRENT_SCHEMA = <global user name>;

COMMIT;

6. To ensure the schema does not already contain data, run this command:
select * from all_objects where owner = '<global user name>';

If there is no response, the schema contains no data.

CAUTION! If the schema contains data do not run the script, because it
overwrites the data without warning and can corrupt the resulting database. To
preserve existing data, use a new tablespace and schema name when installing
MDCStore Data Manager on Oracle.

7. In the SQL*Plus Worksheet, click File > Open and select the appropriate Installation.sql
file. To locate the .sql file, click All Programs > MDCStore > MDCStore Database >
Scripts > MDCStore Install Script (Oracle).

8. Click Execute to create the database in the specified schema.
The MDCStore Data Manager database schema is installed. To set up user accounts for
the MDCStore Data Manager database, see Creating User Accounts for the MDCStore
Database on page 22.
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Creating User Accounts for the MDCStore Database
By default, there is a single user account for the MDCStore Data Manager database: the
SYSTEM account. If multiple users need to access the database, log in using the SYSTEM
account and create and configure separate accounts for each user so that they do not need
to use the SYSTEM login.

To create user accounts for the MDCStore Data Manager database, use the MDCStoreTools™
Utility. See the MDCStoreTools Database Management Utility User Guide included on the
MetaXpress Software Installation flash drive.
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Chapter 4: Configuring the Database Client Software

To test the connection to the MDCStore Data Manager database, you must install and
configure the Oracle or SQL Server database client software on a client computer as
described in this section.

Topics in this section:

Prerequisites on page 23
Information You Need on page 23
Installing and Configuring the Oracle Client on page 24
SQL Client Configuration on page 42

Prerequisites
Before you begin, you must install and configure the MDCStore Data Manager database
schema for SQL Server or Oracle as described in the following chapters:

Installing the MDCStore Data Manager Database Schema for SQL Server on page 7
Installing the MDCStore Data Manager Database Schema for Oracle on page 15

Note: When installing and setting up an Oracle database client on Windows 7, make
sure that you have logged into Windows 7 with full administrator rights, and that you
have full access to the folder where the database is to be installed. Molecular Devices
recommends that you set the User Access Control (UAC) on the computer to the
lowest security setting.

Information You Need
When you configure the database clients, you need to know:

The port number and other settings used by your MDCStore database.
Whether your operating system and database software are 32-bit or 64-bit.

4
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Installing and Configuring the Oracle Client
If you are using an Oracle database, you must install and configure the Oracle client drivers
and services on all MDCStore Data Manager clients as described in this section.

CAUTION! You must install the database client (32-bit or 64-bit) that matches your
operating system.

Oracle installation and configuration tasks include:

Oracle Client Installation and Configuration on page 24
Configuring the Oracle Net Service on page 34
Configuring the Oracle ODBC Data Source on page 38

Oracle Client Installation and Configuration
To install and configure the Oracle client:

1. Log in to the client computer.
2. Download the appropriate Oracle database client drivers from

http://www.oracle.com/technology/software/products/database/index.html.

Note: You must install the appropriate version of the database client to access
the database. The 64-bit version of the database client must be installed with the
64-bit version of the MetaXpress Software to connect to the database.
The AcuityXpress software is only a 32-bit application, which requires the
installation of the 32-bit version of the database client.

3. Unzip the downloaded package and double-click setup.exe to start the installation.
4. In the Welcome dialog, click Next.

http://www.oracle.com/technology/software/products/database/index.html
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5. In the Select Installation Type dialog, click Custom.
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6. If your system uses a language other than English (United States), click Product
Languages, select English (United States) and then click Next. This ensures that the
Oracle installers use English (United States) regional and language settings, which are
required for the MDCStore Data Manager.
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7. In the Specify Oracle Home User dialog, specify the Windows User and Password and
then click Next.
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8. In the Specify Installation Location dialog, select the installation location and then click
Next.
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9. In the Available Product Components dialog, ensure that the following check boxes are
selected:

Oracle Administration Assistant for Windows
Oracle ODBC Driver
Oracle Net
SQL Plus
Oracle Connection Manager

10. Click Next.
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11. Resolve any issues identified in the Perform Prerequisite Checks dialog, and then click
Next.
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12. In the Summary dialog, expand the New Installations section to verify that the
installation summary includes the correct version of the ODBC driver, and then click
Install.

The software installs.
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13. When the Oracle Net Configuration Assistant: Welcome dialog is displayed, click Cancel
then click Yes.
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14. When the Oracle Net Configuration Assistant failed dialog is displayed, click OK.

15. Follow the on-screen instructions to complete the installation. If prompted, skip any
additional service configurations during this installation.
The Oracle client software installation is complete.

Configuring the Oracle Net Service
To configure the Oracle Net Service:

1. On the MDCStore server or client, click Start > All Programs > Oracle Client >
Configuration and Migration Tools > Net Manager.
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2. In the Oracle Net Manager window, select Service Naming, and then click the green

plus sign ( ).

The Net Service Name wizard is displayed.
3. In the Welcome dialog, in the Net Service Name field, type a name for the service, and

then click Next.
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4. In the Protocol dialog, select TCP/IP, and then click Next.

5. In the Protocol Settings dialog, type the host name of the server that hosts your Oracle
database and the port number that the database server listens to, and then click Next.
The default Port Number for Oracle is 1521.
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6. In the Service dialog, type the service name that is used by the Oracle database you are
connecting to, or provide the system identifier, and then click Next.
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7. Click Test to verify your settings.

If the configuration is complete, a confirmation message is displayed.
If a problem is detected try changing the username and password to a valid account and
click Test to verify your settings again.

Configuring the Oracle ODBC Data Source
32-bit applications can use only data sources configured with a 32-bit ODBC driver and 64-bit
applications can use only data sources configured with a 64-bit ODBC driver.

Molecular Devices recommends that you configure new data sources using the New Data
Source button on the dialog that is displayed when you start the MetaXpress Software. For
instructions, see “Set Up the MetaXpress Software” in the MetaXpress Software Installation
Guide included on the MetaXpress Software Installation flash drive.

If you do not have MetaXpress Software or AcuityXpress Software installed on the client
computer, you can configure the ODBC data source using the Administrative Tools section of
the Windows Control Panel as described in the following procedure.

Note:If your client computer is running Microsoft Windows 7, and if the User Access
Control (UAC) is enabled, you must log in using the main Administrator account, not
the local Administrator account, to create a data source. To access UAC, go to Control
Panel > User Accounts.

You can use this procedure to configure a data source.
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Note: Do not use this procedure if you have MetaXpress Software or AcuityXpress
Software installed on the client computer. Molecular Devices recommends that you
configure new data sources by clicking the New Data Source button on the dialog
that is displayed when you start the MetaXpress Software. For instructions, see “Set
Up the MetaXpress Software” in the MetaXpress Software Installation Guide included
on the MetaXpress Software Installation flash drive.

To configure the Oracle ODBC data source using Control Panel:

1. On the client computer, go to the Administrative Tools section of the Windows Control
Panel.

2. in the Administrative Tools list, double-click Data Sources (ODBC), and then click the
System DSN tab.
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3. Click Add.

4. In the Create New Data Source dialog, select the Oracle driver provided by Oracle
Corporation.
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5. Click Finish.
The Oracle ODBC Driver Configuration property sheet is displayed.

6. In the Data Source Name field, type the name of your data source. This name must be
the same for all MDCStore Data Manager servers and clients.

7. In the TNS Service Name field, select a name from the list. The TSN Name must match
the name of the service that is set up in the Oracle NetManager.

8. In the User ID field, type the ID of a user account that has access to the MDCStore Data
Manager database.

9. Click Test Connection.
If the connection test is successful, data source configuration is complete. If a problem is
detected, change your connection settings and try again.
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SQL Client Configuration
If you are using the SQL Server database, you can configure the SQL client on the MDCStore
Data Manager clients as described in this section.

Configuring the SQL Client

NOTE: 32-bit applications can use only data sources configured with a 32-bit ODBC
driver and 64-bit applications can use only data sources configured with a 64-bit
ODBC driver. AcuityXpress Software only supports a 32-bit ODBC connection.

Molecular Devices recommends that you configure new data sources by clicking the New
Data Source button on the dialog that is displayed when you start the MetaXpress Software
or AcuityXpress Software. For instructions, see Setting Up theMetaXpress Software in the
MetaXpress Software Installation Guide included on the MetaXpress Software Installation
flash drive.

If you do not have MetaXpress Software or AcuityXpress Software installed on the client
computer, you can configure the ODBC data source using the Administrative Tools section of
the Windows Control Panel as described in the following procedure.

CAUTION! Do not use this procedure if you have MetaXpress Software or
AcuityXpress Software installed on the client computer.
Molecular Devices recommends that you configure new data sources by clicking the
New Data Source button on the dialog that is displayed when you start the
MetaXpress Software. For instructions, see “Setting Up the MetaXpress Software” in
the MetaXpress Software Installation Guide included on the MetaXpress Software
Installation flash drive.

To configure the SQL client using Control Panel:

CAUTION! The following procedure is only for the 64-bit version of MetaXpress
Software and will not work for the 32-bit version of AcuityXpress Software.

1. Log in to the client computer.
2. Go to the Administrative Tools section of the Windows Control Panel.
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3. Double-click Data Sources (ODBC), and then click the System DSN tab.
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4. Click Add.
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5. In the Create New Data Source dialog, select SQL Server, and then click Finish.
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6. In the first dialog of the Create a New Data Source to SQL Server wizard, type the name
and description of the SQL Server data source, select the server you want to connect to,
and then click Next.

Note: If you do not see your local server listed, try using (local)\Instance
[for example, (local)\SQLEXPRESS].
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7. In the second dialog of the wizard, provide authentication information, and then click
Next.

8. In the third dialog of the wizard, select the Change the default database to check box
and choose the database you are using as the MDCStore Data Manager database.
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9. Select the Use ANSI quoted identifiers and Use ANSI nulls, paddings and warnings
check boxes, and then click Next.

10. Select the Perform translation for character data check box.
11. Clear the Use regional settings when outputting currency, numbers, dates, and times

check box, and then click Finish.
12. In the final dialog of the wizard, test your data source connection by clicking Test data

source and then following the on-screen instructions.
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Chapter 5: Updating an Existing MDCStore Data
Manager Database Schema

This section explains how to update the MDCStore Data Manager database schema from
version 2.0 or above to version 2.3.

Topics in this section:

Prerequisites on page 23
Information You Need on page 23
Installing and Configuring the Oracle Client on page 24
SQL Client Configuration on page 42

Prerequisites
Before you install the MDCStore Data Manager database schema, verify that the current
version is version 2.0 or later. If you have an earlier version of the MDCStore Data Manager
database schema, you must update to at least version 2.0 before you can update to version
2.3. For instructions, see the MDCStore Data Manager 2.0 installation guide, which is included
on the MetaXpress Software and AcuityXpress Software version 2.0 CDs.

In addition, Molecular Devices highly recommends that you back up your database before
you update the schema.

Note: Molecular Devices is not responsible for damage to existing user data that
could happen due to network problems, power failure, unexpected termination of
the update process, or customization of the existing MDCStore Data Manager
database. You should make a full backup of the database before beginning the update.

Required Documents
Before you install the MDCStore Data Manager database schema, you should review the
information in the following documents:

Molecular Devices High Content Screening Computer Specifications
Molecular Devices Complete Solution HCS IT Requirements

These documents are available in the knowledge base on the Molecular Devices support site:
www.moleculardevices.com/support.

5

http://www.moleculardevices.com/support.html
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Choosing the Appropriate Installer
The MDCStore Data Manager database schema installer is available on the MetaXpress® High-
Content Image Acquisition and Analysis Software Installation flash drive and also as a
standalone installer. The software must be installed on a 64-bit operating system.

If you are installing from the MetaXpress Software Installation flash drive,install the
provided 64-bit version. For complete instructions, see the MetaXpressHigh-Content
Image Acquisition and Analysis Software Suite Installation and Update Guide.
If you are installing from a standalone installer, make sure that you download the
appropriate version. Instructions for using the standalone installer are included in this
chapter. See Using the Standalone Installer on page 8.

Updating from Version 2.0 or Newer to Version 2.3
Using the Standalone Installer

To update the MDCStore Data Manager database schema from the standalone installer:

1. Log in to the computer where you want to install the MDCStore Data Manager database
schema.

For SQL, use sa as the login name.
For Oracle, use system as the login name.

If you are installing from the MetaXpress Software Installation flash drive, see the
MetaXpress High-Content Image Acquisition and Analysis Software Suite Installation and
Update Guide.

Note: If your database administrator has deactivated or removed this account
from the MDCStore Data Manager, you now need access made available.

2. Right-click the downloaded MDCStore Data Manager archive file and select Run as
Administrator.

3. In the WinZip Self Extractor dialog, click Setup.
The system checks for prerequisites.
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4. If required components are missing, a warning is displayed, and you must click Install to
install the components and continue. Follow the installation instructions for any required
components.
When the prerequisite check is complete and all required components are installed, the
MDCStore Database Installer Setup Wizard dialog is displayed.

5. Click Next and follow the on-screen instructions to set up the MDCStore Data Manager
database schema installer.
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6. In the Confirm Installation dialog, click Next to start the database installation.
During the installation, the Setup MDCSTORE dialog is displayed.
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7. Click Install\Upgrade MDCStore.
The Setup MDCSTORE message is displayed.
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8. Click Yes.
The Database Installation and Update dialog is displayed.

9. In the Update an existing database section, choose one of the following options:
To update the SQL Server database on the server you are logged into, selectUpdate
database on this computer, select the database you want to update, and then click
Update.
To update an Oracle database, or to update the SQL Server database on a different
server, click Update a database on the network, and then click Update.

10. Read the warning information, and then click OK to acknowledge that you are ready to
update the database.

11. If you are updating the SQL Server database on the server itself, type the user name and
password required to access the database, and then click OK.
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12. If you are updating an Oracle database, or the SQL Server database on the network,
select the data source you want to connect to, type the login name and password of an
account with database administrator privileges (for example, sa or system), and then
click OK.

13. For Oracle databases, select the database schema you want to update, and then click OK.

When the update is complete, a message is displayed stating that the database has been
updated successfully.
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Appendix A: Installing SQL Server 2014 Express

This appendix explains how to install Microsoft SQL Server 2014 Express 64-bit, which is
referred to as SQL Express throughout this appendix. SQL Express is useful for demonstration
or evaluation purposes. However, the SQL Express database is limited to 10 GB in size, so it is
impractical for production environments.

Microsoft SQL Server 2014 Express is included on the MetaXpress Software Installation flash
drive and can be installed using the following procedures.

Note: Molecular Devices recommends that you do not install SQL Express if either
SQL Server 2005, SQL Server 2012, or SQL Server 2014 is already installed.

Topics in this appendix:

Accessing the SQL Express Installer on page 57
Enabling Named Pipes and TCP/IP Connections on page 57

Accessing the SQL Express Installer
Microsoft SQL Server 2014 Express 64-bit is included on the MetaXpress Software
Installation flash drive. It can be installed by following procedure in the MetaXpress High-
Content Image Acquisition and Analysis Software Suite Installation and Update Guide that is
provided on the MetaXpress Software Installation flash drive and is available in the Molecular
Devices knowledge base at www.moleculardevices.com/support.

After installing SQL Express, you must enable named pipes and TCP/IP connections and
ensure that the SQL Browser service is running so that remote users can connect to this
instance of SQL Server Express. See Enabling Named Pipes and TCP/IP Connections on page
57.

Enabling Named Pipes and TCP/IP Connections
To enable named pipes and TCP/IP connections:

1. Click Start > All Programs > Microsoft SQL Server 2014 > Configuration Tools > SQL
Server Configuration Manager.

A

http://www.moleculardevices.com/support.html
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2. In the left pane of the Sql Server Configuration Manager, expand SQL Server Network
Configuration, and then select Protocols for SQLEXPRESS.

3. In the right pane of the Sql Server Configuration Manager, right-click Named Pipes, and
then click Enable.

4. In the right pane of the Sql Server Configuration Manager, right-click TCP/IP, and then
click Enable.

5. Close the SQL Server Installation Center dialog.

Note: If you have Windows Firewall running on your server computer, then you
must add the Microsoft SQL Server service (sqlsvr.exe) and the Microsoft SQL
Browser service (sqlbrowser.exe) to the firewall Exceptions list so that remote
connections to the database are possible. For assistance, contact your system
administrator.
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